


This program contains XTensions“ that

enable it to be used with QuarkXPress“

for Apple Macintosh. 

QuarkXPress“  is a registered

trademark and product of Quark, Inc.

Only Valid Registered copies of for the

Apple Macintosh computer may be used

with this program.

The software described in this document is provided under a license
from Layout Ltd. and may not be copied or given to another person
or business except as may be provided in this license. Layout Ltd.
makes no warranty of any kind with regard to this material, including
but not limited to the implied warranties of merchantability and
fitness for a particular purpose. Layout Ltd. shall not be liable for
errors contained herein or for incidental consequential damage in
connection with the furnishing, performance, or use of this material.

The information contained in this document is subject to change
without notice.

Quark, QuarkXPress, and QuarkXTensions are registered
trademarks of Quark, Inc. Portions Copyrighted 1988 - 1997 Quark,
Inc. All rights reserved.

ArabicXT is a trademark of Layout Ltd. registered in Lebanon and
other countries. Portions Copyrighted 1994 - 2002 Layout Ltd. All
rights reserved.

Macintosh is a registered trademark of Apple Computer, Inc.

All other trademarks are the property of their respective owners.

This manual may not, in whole or in part, be copied, photocopied,
reproduced, translated, or converted to any electronic or machine-
readable form without the prior written consent of Layout Ltd.

Quark Disclaimer:
Quark, Inc. makes no warranties, either expressed or implied, regarding the encolsed computer
software package, its merchantability, or its fitness for any particular purpose. Quark, Inc.
disclaims all warranties of the distributors, retailers, and developers of the encolsed software.

Without limiting the foregoing, in no even shall Quark, Inc. be liable for any special, indirect,
incidental, or consequential damages in any way relating to the use or arising out of the use of
the enclosed software. Quark, Inc. s liability shall in no even exceed fifty U.S. dollars ($50.00).

This exclusion of implied warranties and/or the exclusion or limitation of  incidental or
consequential damages is not allowed in some areas, so these exclusions and limitations may
not apply  to you.
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Hardware Requirements
ArabicXT 6.1 requires the following hardware:
Macintosh Version

¥  Power-PC G3 or faster processor 
¥  CD-ROM Drive for Installation
¥  128MB Available Memory/RAM (XPress Requirement)
¥  230MB Available Hard-disk Space (XPress Requirement)
¥  MAC OS X (10.2 or above) 

Software Requirements
ArabicXT 6.1 requires QuarkXPress Version 6.1

ArabicXT Packing List
Your ArabicXT Packing List should include:

¥  ArabicXT Installation CD
¥  Hardware lock key (dongle)
¥  ArabicXT KeyCode paper (only with Full package with dongle).
¥  Registration card

Note
If any of these items are missing, please contact your local dealer immediately.

Getting Started
Welcome to ArabicXT 6.1, the award winning QuarkXTensions“ and powerful
page layout software available today from Layout Ltd.

ArabicXT software is an XTensions to QuarkXPress that allows publishing in
Arabic. ArabicXT turns QuarkXPress into a Bidirectional Professional Electronic
Publishing System that supports the Arabic language. Ideally suited for
professional publishers, ArabicXT is a unique solution that utilizes all features and
direct-editing capabilities of QuarkXPress.

About this Users Manual
This guide is designed to help you master ArabicXT as it provides you with a
complete overview on ArabicXT diverse functionalities to ensure optimal bilingual
publications.  

We assume in this guide that you are already familiar with the MAC OS
environment. Additionally, since ArabicXT is a QuarkXPress XTensions, you
should also be familiar, and have a good working knowledge, with QuarkXPress.

Technical Support
Should you require any help, contact our Technical Support department by 
E-mail, Fax or telephone. Our support team is available 5 days a week, Monday
through Friday, from 8:00 AM till 5:30 PM to assist you and answer all your
queries. 
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Layout Ltd.
Street 50, Sector 2, 
Jisr El-Bacha
Beirut, Lebanon

P.O. Box: 165479
Beirut, 1100 2040
Lebanon

Tel: +961 1 512572
Mob: +961 3 348260
Fax: +961 1 512570

Web: www.layoutltd.com
E-mail: layout@layoutltd.com

sales@layoutltd.com
support@layoutltd.com
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Installing QuarkXPress

Before you install ArabicXT you must install a complete working copy of
QuarkXPress..Please follow the instructions in your QuarkXPress User s Guide to
successfully install your QuarkXPress package.

Installing ArabicXT Dongle 

You should install the dongle before you install the program. All full versions of
ArabicXT for Macintosh are shipped with a USB dongle.

[ 1 ]  Connect the dongle into the USB port.
[ 2 ]  ArabicXT will automatically install the EVE3 Framework  located inside 

the Frameworks  inside the Library folder which is found in your Hard Disk.
This is needed for the system to recognise the USB dongle.

[ 3 ]  Restart your computer.

ArabicXT 6.1
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Installing ArabicXT

Double click the ArabicXT installer and follow the instructions. Choose the
XTension folder inside the QuarkXPress folder where ArabicXT should be
installed. The installer will copy the needed fonts to your system folder, create the
ArabicXT folder which will contain the user guide, and place the ArabicXT
XTension in the selected QuarkXPress XTension folder.

Shut down and connect the protection Key "dongle" to the USB port.

Restart the computer and launch QuarkXPress.

Registering ArabicXT
Complete the ArabicXT registration card and mail it to the address shown on the
card. By registering ArabicXT, you enter into our customer database and are
entitled to receive 10 free Arabic fonts, free customer support and a 90-day
warranty on your software, including free updates.

ArabicXT Activation 
For more details regarding ArabicXT Installation and Activation, refer to the
addendum found on this CD to know all the facts of starting ArabicXT with the
Dongle based KeyCode Scheme. 

InstallationArabicXT 6.1
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When a text box is still empty, you can tag it back and forth from Latin to Arabic.
When the text box is filled with text, you cannot change its language tag unless
you empty the text box.

Note
You can set the default language tag that will be used every time you create a
new text box. See ArabicXT Preferences section.

Set Ligatures ON/Set Ligatures OFF
ArabicXT has a pre-set function that allows the use of ligatures in Arabic. A
ligature is a collection of 2 to 3 characters that form a single character, such as
the following:

Ù instead of `ëªd

¥  If you want to apply ligatures on a text. Select the text and choose Set 
Ligatures On  in the Arabic menu.

¥  If you want to remove ligatures on a text. Select the text and choose Set 
Ligatures Off  in the Arabic menu.

Note
The default ligature selection can be turned On and Off from the ArabicXT
Preferences dialog box. See ArabicXT Preferences section. 

Copy Attributes/Paste Attributes
These menu commands are very useful when you want to apply the same font, 
size, color, shade, and type style to text more than once:
[ 1 ]  Select a range of text with attributes to be copied.
[ 2 ]  Choose Copy Attributes  (Ctrl+Alt+C for Mac) in the Arabic menu.
[ 3 ]  Select the text on which you would like to apply the attributes.
[ 4 ]  Choose Paste Attributes  (Ctrl+Alt+V for Mac) in the Arabic menu.

ArabicXT adds a new Arabic  menu entry to the QuarkXPress menu bar. This
menu entry contains most of the ArabicXT commands that allow you to integrate
the writing and editing of Arabic text.

Tag Box to Arabic
This menu command allows you to tag a text box to Arabic, which will mark it  as
an Arabic box:
[ 1 ]  Choose any of the text box tools from the tools palette and draw a text box. 
[ 2 ]  Choose the content tool from the tools palette.
[ 3 ]  Go to the Arabic menu and choose Tag Box to Arabic  (Ctrl+A for Mac).

This will move the cursor to the right and will automatically set the type style
to the default Arabic font and size.

Tag Box to Latin
This menu command allows you to set the text box language to Latin 
(i.e. English, French or any Roman language):
[ 1 ]  Choose any of the text box tools from the tools palette and draw a text box. 
[ 2 ]  Choose the content tool from the tools palette.
[ 3 ]  Go to the Arabic menu and choose Tag Box to Latin  (Ctrl+L for Mac).  

This will move the cursor to the left and will automatically set the type style 
to the default Latin font and size.

ArabicXT 6.1
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Include Space After Word

Select to include the space after the word. The space will also be dropped. You
may also choose the Font, Color, Shade, and Scaling factor for the word to be
dropped.
Example:   
Drop Word over 2 lines with the space included To remove the drop word effect
from selected paragraphs:
[ 1 ]  Select the paragraph(s) that has Drop Word
[ 2 ]  Go to Layout Utilities  in the Arabic menu.
[ 3 ]  Select Remove Drop Word  (Ctrl+Alt+W).

Change Numbers Font
This menu command is
used frequently when you
need to change all
numbers in a story from
Arabic into Latin.  It allows
you to change the font for
numbers in the current
story, or the entire
document:
[ 1 ]  Go to Layout

Utilities  in the Arabic
menu.

[ 2 ]  Select Change
Numbers Font . 
The following dialog

Layout Utilities
Drop Word/Remove Drop Word
QuarkXPress allows you to drop a character at the beginning of a paragraph over
a number of lines, using Drop Cap  in the Formats command under the Style
menu.  Since Arabic text requires that a whole word be dropped instead of one or
2 characters only, ArabicXT allows you to do this quickly:
[ 1 ]  Go to Layout Utilities  in the Arabic menu.

[ 2 ]  Select Drop Word  (Ctrl+W). The following dialog box will be displayed:

Line Count
Specify the number of lines you wish the first word of the paragraph to drop.

Baseline Shift
Specify the amount of baseline shift in points that you want to apply to the word.
This option allows you to shift the word up or down to best fit the design.

 ábÓ£fGÊÉæÑ∏dG …OÉædG Qôb ÚM 1968 ΩÉY âfÉc ,kÉ≤HÉ°S πÑ÷G ‹GQ á«ª°ùJ πªëj ¿Éc …òdG ‹hódG ¿ÉæÑd ‹GQ

HÉ£dG πªëj çóM áeÉbEG ¿ÉæÑd ‘ äGQÉ«°ù∏d ‹hódG OÉ–Ód ó«MƒdG πãªŸG ƒgh ,áMÉ«°ùdGh äGQÉ«°ù∏d

,πÑ÷G ‹GQ º°SEG ¬«∏Y ≥∏WCG …òdG ¬«dGQ (1917 ΩÉY ¢ù°SCÉJ) á≤£æŸG ‘ …OGƒædG ΩóbCG øe Èà©j …òdG …OÉædG º¶f π©ØdÉHh .‹hódG

,¬«a ácQÉ°ûª∏d ÖfÉL’G Ú≤FÉ°ùdG  RôHCG ÜÉ£≤à°S’ äOCG Ió«L á©ª°S ¬Ñ°ùcG …òdG ôeC’G º«¶æàdG ø°ùëH õ«“ kGRQÉH kÉKóM ¿Éc óbh

hQófÉ°S ‹É£jE’Gh ,ÆÈehÎ°S ’hG ¬æWGƒeh  ÉHhQhG ` ÉJƒjƒJ ≥jôa ôjóe Ö°üæe kÉ«dÉM π¨°ûj …òdG ¿ƒ°SQófG ‘hCG …ójƒ°ùdG ¿CÉ°T

…GQhG ¿’CGh »Jƒ«fGQ ¿ÉL Ú«°ùfôØdGh ,ƒjQƒ«a ¢ùµ«dG ¬æWGƒeh 1977 ΩÉY äGQÉ«°ùdG á°VÉjôd ‹hódG OÉ–E’G ¢SCÉµH õFÉØdG …QÉfƒe

.…ôLÉ¡dG ó«©°S …ô£≤dGh º«∏°S øH óªfi »JGQÉe’G º¡æeh Ú«£°ShCG ¥ô°ûdG Ú≤FÉ°ùdG RôHCG øe Oó©d áaÉ°VEG ,ÊhQÉH QGõ«°S QÉ«Hh
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Insert Arabic in Latin
This menu command is often needed when the  initial text box is tagged to Latin,
and only few Arabic words are needed. It allows you to enter Arabic text in a
Latin box:
[ 1 ]  Position cursor in the Latin text box in which you need to type or copy 

Arabic.
[ 2 ]  Go to Layout Utilities  in the Arabic menu.
[ 3 ]  Select Insert Arabic in Latin and type Arabic words.
[ 4 ]  Press the Return key, or click the Insert Text button.

Put Arabic Text on Curve
This menu command allows you to insert Arabic
text on QuarkXPress bezier curves:
[ 1 ]  Use the Bezier curve tool  to draw a curve.
[ 2 ]  Go to Layout Utilities  in the Arabic menu.
[ 3 ]  Select Put Arabic Text on Curve  and 

type your Arabic text. The text will flow 
on the curve.

Note
For best results when putting Arabic text on curves, you should have Adobe Type
Manager and Type 1 Arabic fonts installed on your system.

Sort Arabic Text
This menu command sorts Arabic paragraphs in an active Arabic text box.  A
dialog box is displayed to choose the ascending or descending order of sorting.

Note
When creating indexes for books with QuarkXPress in Arabic, after QuarkXPress
creates the index, you must re-sort the Arabic box using the Sort Arabic Text
command (see Creating an Arabic Index  section, in the next chapter).

box will be displayed:
Font
Select the font you would like to apply to numbers.

Change In
Choose either selected text, current story, or document in which you would like to
change numbers.

Scale
Change the font size up or down in percentage.
Size
Specify a precise point size to be used.  This is needed because, in general, Latin
fonts have a higher cap than Arabic fonts.  Designers usually choose a slightly
smaller point size for Latin fonts when mixing with Arabic text.

Separators
Specify decimal and thousands separators while converting the fonts. This will
also change the different number seperators to new seperators

Flip Numerics
Since some word processors save numbers in reverse order, users may face
problems when importing Arabic text into their desktop publishing applications. 

In ArabicXT, this menu command simply reverses the number:
[ 1 ]  Select the text box that contains the numerics to be reversed.
[ 2 ]  Go to Layout Utilities  in the Arabic menu.
[ 3 ]  Select Flip Numerics .  

All numbers in the selected story will be reversed
Example 1:   6991 will become 1996.
Example 2: 

ArabicXT Menu Items | 17
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Empty Control
Select Text Boxes to automatically remove all text from all text boxes.  Text
boxes are then ready to receive translated text.

Select Picture Boxes to automatically remove all pictures from the picture boxes.

Flip Control
Select Pictures to automatically flip pictures in their boxes.
Select Box Angles to reverse the angle of a box to read correctly.  For example, if
a box is rotated to 45 degrees in the Latin layout, it will be rotated to -45 degrees
in the Arabic layout. (See sample above.) Select Blend Angles to automatically
reverse the color blend angles of boxes.

Get Windows Arabic Text (Ctrl+E for Macintosh Only).
This menu command allows you to import Windows Arabic text files directly into
Arabic boxes without having to go through the WinToMac converter or any other
converter:
[ 1 ]  Select Tag Box to Arabic  (Ctrl+A) in the Arabic menu.
[ 2 ]  Go to Layout Utilities  in the Arabic menu.
[ 3 ]  Select Get Windows Arabic Text  (Ctrl+E). The Windows Arabic text 

will be imported into the active Arabic box.

Note:If you put the sequence [ XPTWIN ]  at the begining of the Windows Arabic
file, then even if you do the normal get text, the windows text will come correct. 

Flip Document Layout
When you create bilingual publications, you may need to flip a whole document
layout from right to left, or left to right. 

This menu command allows you to flip entire
objects on a page according to the
center of the page or spread:
[ 1 ]  Go to Layout Utilities  in the

Arabic menu.
[ 2 ] Select Flip Document Layout .

The following dialog box will be
displayed:

Center of Page
Select to flip the current
page or selected pages
according to the center
of the page. 

Select the current page,
all pages, or selected
pages to flip according
to the center of the
page.

Center of Spread
Select to flip the current
spread or selected

spreds according to the center of the whole spread. This is used in facing pages
or brochures with more than one page on the same spread.

Select the current spread, all spread, or selected spreads to flip according to the
center of the whole spread.

ArabicXT Menu Items | 19
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This logic has the following limitations:
¥  Latin strings inside Arabic boxes will break at the end of lines in the wrong

reading order.

Note
Once an ArabicXT 2.5 or earlier document is saved with ArabicXT 6.0,  5.0, 4.x
or 3.0, it will not open correctly in ArabicXT 2.5

Enhanced Mixing is used in ArabicXT 3.0 or later documents. If you are
publishing an Arabic document which contains Latin paragraphs within Arabic
text, you should choose Enhanced Mixing, which allows you to mix Latin text with
Arabic text while keeping the correct reading order for Latin line breaks. This
slows performance somewhat, but the result is good.

The following restrictions, however, apply:
¥  The Auto Kern Above  is set to Off for all new documents.
¥  You cannot have different text attributes inside the same Latin string in an

Arabic box.

To have Standard and Enhanced Arabic text boxes in the same document, we
have developed 2 shortcuts:

¥  Ctrl+Opt+Shift+S
This shortcut key converts the selected text box from Enhanced Mixing to
Standard Mixing. If no text box is selected, this shortcut key converts the
whole document from Enhanced to Standard Mixing.

¥  Ctrl+Opt+Shift+E
This shortcut key converts the selected text box from Standard Mixing to
Enhanced Mixing. If no text box is selected, this shortcut key converts the
whole document from Standard to Enhanced Mixing.

Note
Converting from Standard to Enhanced Mixing will cause Auto Kerning to be

ArabicXT Preferences
The ArabicXT
Preferences dialog
box allows you to
modify some of the
default behavior of
ArabicXT.

Default Text Boxes
Select Latin or
Arabic as the default
language in which to
tag a text box as
soon as it is created.

Vowel Levelling
Arabic vowels are automatically positioned vertically and horizontally over the
Arabic character, depending on the height of the character. Input a percentage to
control the maximum amount of baseline shift vowels can take when ArabicXT
positions vowels.

Mixing
Mixing specifies the mixing Latin with Arabic
text logic that ArabicXT follows. Two options
are available: Standard and Enhanced.

Standard Mixing is used in ArabicXT 2.5 or earlier documents. If you are
publishing an Arabic document which does not contain Latin paragraphs within
Arabic text, you should choose Standard Mixing, which works faster and does not
turn Auto Kerning Off.

20 | ArabicXT User’s Manual 
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Mixing Latin with Arabic
To switch language from Arabic to English in an Arabic box, press the control key
and right arrow (Ctrl+ ->) for Mac.
Example:   
[ 1 ] Create a new text box.
[ 2 ] Go to the Arabic menu and choose Tag Box to Arabic  (Ctrl+A for Mac).
[ 3 ] Type your Arabic string.

[ 4 ] When you wish to insert Latin text, press (Ctrl+ ->) for Mac
[ 5 ] The text font and style will automatically be set to the default Latin font 

defined in the Normal Style Sheet.
[ 6 ] Type your Latin text.

[ 7 ]  To switch back to Arabic, press (Ctrl+ <-) for Mac.
[ 8 ]  Continue typing your Arabic text.

Editing Latin Text in an Arabic Text Box

ArabicXT offers a convenient way of editing Latin text in an Arabic text box:
[ 1 ]  Select a Latin text string.
[ 2 ]  Press the control key, option key, and right arrow (Ctrl+Opt+  ->) for Mac .

This will copy the Latin text to a small editing window, as shown below:
[ 3 ]  Type or edit the Latin text.
[ 4 ]  Press the OK  button, and the edited string will replace the original one.

Note
The Latin text editor is limited to 256 characters only. Attempting to edit longer
text selections will result in an alert message. 
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Working with Arabic text

 á«Hô©dG ™e á«æ«J’G êõe øY ∫Éãe Gòg

  á«Hô©dG ™e á«æ«J’G êõe øY ∫Éãe GògThis is English text

turned Off, which might cause documents to reflow.

Ligature Selection
Click for the default setting of Ligature Selection. From the Arabic menu, you may
also Set Ligature ON  and Set Ligature OFF  on a range of selected text.

Force Arabic Numbers When Importing Text
Click to force numbers in imported text to convert to an Arabic font. This is helpful
when you are importing text with Latin numbers, and you wish to force them to
Arabic.

Kashida Control
Select Insert Automatic Kashida  to automatically insert Kashidas, small
connecting characters, when text is justified, for printing and on screen. When you
preview Kashida on screen, it will not show if you are in content mode 
(i.e., cursor is showing).  As soon as you go to drag mode (i.e., arrow is showing)
by de-selecting the text box, Kashida will show.

When Preview Kashida On Screen  is selected, screen refreshes are slowed
down.

ArabicXT 6.1
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[ 3 ]  Only Latin text in the selection range is affected. The Arabic text remains the
same.

Changing the Font for Arabic Text Only

:á∏àµdG ¢ùØf ‘ á«Hô©dG ™e á«æ«J’G êõe øY ∫Éãe Gòg

This is some mixed English/Arabic Text¢ùcG ∂«HGQG .

.§îdG Ò«¨J óæY á∏ª©à°ùŸG ¢üædG á¨d ≈∏Y ßaÉëj »J

ArabicXT 6.1

Editing Latin Text in an Arabic Text Box works for Enhanced mixing and not for
Standard mixing.

Changing Text Attributes by Language
ArabicXT allows you to apply text attributes to a selection of text by language.

Changing the Font for Latin Text Only
If you have mixed Latin/Arabic text in one box, and you wish to change the font of
only Latin text without affecting the Arabic text:
[ 1 ]  Select the text you wish to affect:

[ 2 ]  Go to the Style menu. Pull down Font  and select a Latin font.

:á∏àµdG ¢ùØf ‘ á«Hô©dG ™e á«æ«J’G êõe øY ∫Éãe Gòg

This is some mixed English/Arabic Text¢ùcG ∂«HGQG .

.§îdG Ò«¨J óæY á∏ª©à°ùŸG ¢üædG á¨d ≈∏Y ßaÉëj »J
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[ 3 ]  Only English text is affected. The Arabic text remains unchanged.

To Affect Arabic Text Only in a Mixed Language Selection:
[ 1 ]  Select the text chain you wish to affect.
[ 2 ]  Before you open the Style menu, hold down the control key (Ctrl) for the

Mac.
[ 3 ] When you choose the command from the Style menu, only Arabic text is

affected.

If you have mixed Latin/Arabic text in one box, and you wish to change the font of
only Arabic text without affecting the Latin text:
[ 1 ]  Select the text chain you wish to affect.
[ 2 ]  Go to the Style menu. Pull down Font  and select an Arabic font. Only

Arabic text in the selection range is affected. The Latin text remains 
the same.

Note
If you select a mixed language text and change the font from the Measurement
palette, all text selected is affected.

Changing Type Style by Language
Within a mixed language text, you can change the Type Style including Color,
Style, Shade, Scaling, and Baseline Shift of a specific language.

To Affect English Text Only in a Mixed Language Selection
[ 1 ] Select the text.
[ 2 ] Before you open the Style menu, hold down the command key ( ) for the

Mac . 
[ 3 ] When you choose the command from the Style menu, only English text is 

affected.

Example:   
How do you change the point size of English text in a mixed text string?
[ 1 ]  Select the mixed language text.

[ 2 ]  Hold down the ( ) key for Mac  while you select the desired size from the
Style menu.

Working with Arabic Text
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Replacing Arabic Text

[ 1 ] Follow the first 6 steps above.
[ 2 ] Under Change To , check the Arabic check box.  This will allow you to 

type Arabic text.
[ 3 ] Type the Arabic text to which you wish to change the found text.
[ 4 ] Select the Font, Size, and Style of the text, if you wish to change the 

specific text styles.
[ 5 ] Click one of the following buttons:

Find Next: Click to find the next occurence of text to be changed.
Change, Then Find:  Click to replace the current text and to find the next 
occurence of text to be changed.
Change: Click to replace only the currently found text to be changed.
Change All: Click to replace every occurence of the text to be changed 
throughout the text box.
Document: Check box to search the entire document.
Ignore Ligatures: If you have selected Set Ligatures ON  while working 
with the document, the same words could be written differently: 

i.e:  πÙG and πÙG. Click Ignore Ligature to find both words anyway.
Ignore Accents:  Click Ignore Accents if you have used vowels but wish to

ignore them while searching for words.
Ignore Attributes:  Click this box to ignore the Font, Size, and Style of the

text you want to find.  For example, you may wish to
search for all occurrences of the word πÙG, using any
text style.

Changing the Default Arabic Font

When first installed, ArabicXT adds a new Arabic Style  style sheet to the
QuarkXPress default styles. Every time you create a new text box and start typing
Arabic text, the Arabic Style  style sheet is used. The default is 14-point
AXtGihaneLight.

Searching and Replacing Arabic Text
This menu command allows you to search Arabic text or search and replace
Arabic text.

Searching Arabic Text
[ 1 ] Select the Arabic text box in which you want to find a word or string of 

words.
[ 2 ] Select Find/Change  from the Edit menu. The above dialog box will be 

displayed.
[ 3 ] Under Find what , check the Arabic check box.  This will allow you to type 

Arabic text.
[ 4 ] Type the Arabic text you wish to find.
[ 5 ] Select the Font, Size, and Style of the text, if you wish to search for specific 

styled text, these will appear if you do not choose Ignore attributes.
[ 6 ]  Click the Find Next  button.

Note:
For normal QuarkXPress Find / Replace, you should either have a latin text box
selected or no text box at all selected before you invoke this command.

Working with Arabic Text
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[ 7 ]  Click the Save  button to save the new settings.

Changing the Default Latin Font
When you insert Latin text in an Arabic text box, or when you tag a new text box
to Arabic, the font, style, and formats set in the Normal style sheet are
automatically used. 

To change the Normal default style sheet, edit the Normal Style Sheet to define
your English default font and size.
[ 1 ]  From the Edit menu, choose Style Sheets .
[ 2 ]  Select Normal .
[ 3 ]  Click the Edit  button to edit the style sheet.
[ 4 ]  To edit the Character Attributes for this style sheet, click the Edit  button. 

Choose a Latin Font, Size, and Style you wish to use.

[ 5 ]  Click the OK  button.
[ 6 ]  Click the Save  button to save the new settings.

Tip
When you have Arabic text mixed with Latin text, always set the Latin text at least
20% smaller in size than the Arabic text. Arabic text has a smaller cap size than
Latin text.

Note
When you import Arabic text into an Arabic text box which contains mixed Latin
and Arabic strings, Arabic Style  is used by default for Arabic text and Normal
style is used by default for Latin text.

Controlling Automatic Kashida Insertion
When Arabic text is justified, extra spacing should be compensated by inserting a
Kashida, a small connection character, between connecting characters (-).  You
may select or de-select this option in the Kashida Control box in the ArabicXT
Preferences dialog box.

[1 ]  To change this
default,f rom the
Edit menu, choose
Style Sheets .

[ 2 ]  Select Arabic
Style .

[3]  Click the Edit
button to edit the
style sheet. The
below dialog box
will be 
displayed:

[ 5 ]  To edit the
Character
Attributes for this
style sheet, click
the Edit  button. 
Choose the Font,
Size, and Style
you wish to use.

[ 6 ]  Click the OK
button.

Working with Arabic Text
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[ 5 ]  Go to Baseline Shift  in the Style menu.
[ 6 ]  Specify a value and click the OK  button.

Example:   
When typing a Fathatain accent on a Lam Alef, the accent is automatically
positioned over the Lam Alef: kÓ
To select the accent, position your cursor at the end of the character, then press
the shift key and left arrow (Shift+ <-). This selects the accent. 

Change the kerning value from 0 to - 40. This will move the accent to the right by
20th of an EM space.

Setting Arabic Tabs
To set tabs for an Arabic
paragraph:

[ 1 ]  Select the
paragraph or range
of paragraphs for
which you want to
specify new tabs.

[ 2 ]  Choose Tabs
from the Style
menu. The
following dialog box
will be displayed:

[ 3 ]  To specify the
exact location for
each tab, use one
of the following 2
options:

If you want to temporarily turn Kashida On or Off at a specified location in your
text, however, ArabicXT allows you to  manually insert a small Kashida at the
location where you wish to disable inserting Kashidas. The small Kashida key is 
the key.

Example:   
Fully justifying the line Ó¡°Sh ÓgG will result in the following:

If you manually insert a Kashida between the Seen and the Ha, the result will
look like this:

Selecting and Manipulating Vowels
Vowels are floating accents placed above Arabic characters that affect
pronunciation. ArabicXT automatically positions these accents vertically and
horizontally on Arabic characters, depending on their height, width, and position
in a word.

If you want to change an accent s vertical or horizontal position:
[ 1 ]  Position the cursor before the accent.
[ 2 ]  Press the shift key and left arrow (Shift+ <-) to select the accent. Note 
that the text cursor disappears. You will not see any black highlight 
because accent does not have any width. 
[ 3 ]  Go to Kern...  in the Style menu.
[ 4 ]  Specify a value and click the OK  button.

Ó```````````````¡````````````°ShÓ```````````````gG

Ó````````````````````````¡°ShÓ````````````````````gG

~
ỳ ``
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Click to close the dialog box and
apply the new settings.
Cancel: Click to close the dialog
box and ignore the new settings.

Example:   
In this example, the tab was set at
5.8 cm with a dot (.) fill character.
Note how the space is filled with
dots. The tab alignment is right
aligned. Since right results in left in Arabic
boxes, all tabs are left aligned.

In this example, the same settings
were used for the first tab, but left
alignment was chosen. This
results in right alignment in Arabic
text boxes.

In the final example, the same settings
were used for the first tab, but the
alignment was centered with a
space fill character.  Thus, the tab
is filled with a non-displayable
character.

óM’G

ÚæK’G

AÉã∏ãdG

AÉ©HQ’G

¢ù«ªÿG

á©ª÷G

âÑ°ùdG

Center alignment of tabs

óM’G ...............................................................

ÚæK’G.............................................................

AÉã∏ãdG.............................................................

AÉ©HQ’G ..........................................................

¢ù«ªÿG..........................................................

á©ª÷G............................................................

âÑ°ùdG .............................................................

Fill character set to a dot (’.’)

.............................................

óM’G...................................

ÚæK’G ...............................................................

AÉã∏ãdG ...............................................................

AÉ©HQ’G ...............................................................

¢ù«ªÿG ...............................................................

á©ª÷G ...............................................................

âÑ°ùdG ...............................................................

Right alignment
of tabs

Fill character set to a dot (’.’)

Fill character set to a space

Left alignment
of tabs

[ a ]  Ruler:  Specify the exact location for each tab by clicking on the ruler
at the top of the dialog box.
Note:
The ruler is as wide as the selected text box. Remember that Arabic
text boxes read from right to left, while the tabs you specify are from
left to right.

[ b ]  Position: Enter the exact position in the default measurement unit 
(i.e. cm, mm, Inch), Then click the Set button.

[ 4 ]  Set: To apply all tabs you have specified.
[ 5 ]  Clear All: To clear all tabs you have specified.

To align the tabs you have set, use one of the following 2 options:
[ a ]  Alignment Arrows: on the alignment arrows directly under 

the ruler to specify the alignment (left, center,   
right, decimal, comma, align on) for each tab 
you add to the ruler.

Note:
Remember that when the text box is Arabic, left aligned tabs mean
right aligned tabs, and right aligned tabs mean left aligned tabs.

[ b ]  Fill Characters: A fill character fills the space  that the tab occupies.
This could be any 2 characters such as a dot (.) or an underscore
(_). The fill character you specify depends on the font you are using.
Arabic fonts have a different layout than Latin fonts. If you wish to
use a Latin font for the tab, select the tabs and change the font to
any Latin font.
Note
When you specify a fill character in an Arabic tab, the fill character 
will be the equivalent character in the selected Arabic font. You can 
change the font of the tab itself to a Latin font if you want the fill 
character to remain the same.

Apply: Click to apply the settings on the selected paragraph without closing
the dialog box.

OK:

Working with Arabic Text
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Importing XPress Tags
XPress Tags enable you to include character attributes and paragraph formats
when importing ASCII text files. They are codes you can insert while typing text to
apply the attributes when the text is imported. For a complete list of all XPress
Tags codes, refer to the QuarkXPress reference manual.

Importing Arabic Text with XPress Tags
[ 1 ]  From the word processor, save the text to be imported as a Text Only file.
[ 2 ]  Choose Tag Box to Arabic  (Ctrl+A) in the Arabic menu. This will move the

cursor to the right and will automatically set the type style to the default
Arabic font and size.

[ 3 ]  Go to the File menu and select Get Text  (Command+E).
[ 4 ]  Locate your file.
[ 5 ]  De-select Covert Quotes , because this option is not available in Arabic.

Convert Quotes is used to automatically convert quotes from simple quotes
to smart quotes.

[ 6 ]  Select Include Style Sheets.  ArabicXT will read and format Arabic text
according to the embedded XPress Tags.

Your Arabic text is now imported and formatted accordingly.

Converting Arabic Text into Boxes (Curves)
QuarkXPress 6.1 allows you to successfully convert Arabic text into boxes
(curves):
[ 1 ]  In the Arabic text box Select the

Arabic text you would like to
convert to a box.

[ 2 ]  Go to the Style menu to modify
the Font, Size, and Type Style of
the text,if desired.

[ 3 ]  Go to the Style menu and select
Text to Box . The text will be

converted to curves.
[ 4 ]  You can now apply colors and lines to the outlined text, edit its shape, and

place pictures inside, like you would normally do in Latin boxes.

Importing Arabic Text
ArabicXT can import Arabic text from any word processor on the Macintosh or
Windows platforms:  

Importing Arabic Text
[ 1 ] From the  word processor , save the text not as   a Rich Text Only file , or 

other but as a Text Only file (ASCII text).
[ 2 ] Choose Tag Box to Arabic  (Ctrl+A) in the Arabic menu.  This will move the

cursor to the right and will automatically set the type style to the default
Arabic font and size.

[ 3 ] Go to the File menu and
select Get Text
(Command+E) if the texts to
be imported were written on
Mac. The following dialog
box will be displayed:

[ 4 ]  Locate your file.
[ 5 ] De-select Convert Quotes ,

because this option is not
available in Arabic. Convert
Quotes is used to
automatically convert
quotes from simple quotes
to smart quotes.

Importing Arabic Text from Windows
[ 1 ]  From any Windows word processor (like WordPad, Word, NotePad..) ,save 

the text not as  a Rich Text Only file  or other, but as a Text Only file 
(ASCII text)

[ 2 ]  Choose Tag Box to Arabic  (Alt +A) in the Arabic menu. This will move 
the cursor to the right and will automatically set the type style to the default 
Arabic font and size.

[ 3 ]  Choose Layout Utilities  in the Arabic menu.
[ 4 ]  Select Get Windows Arabic Text .  The text will be automatically 

converted from the Windows Code Page to ArabicXT.

Working with Arabic Text
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[ 7 ]  Click the New
button to create a
new list.

[ 8 ]  Name the list
TOC or any 
name you wish to
use.

[ 9 ]  Under Available
Styles , 
select the Chapter
Title and the
subhead style
sheets. Click the
right arrow to
move them to the
Styles in List

area.
[ 10 ] You can decide

on the level of
each style sheet
from the Level
popup menu. Select
Level 1 for the
Chapter Title and
Level 2 for the
subhead.

[ 11 ] From the
Numbering popup
menu, select
whether to include
page numbers.

[ 12 ] Choose the style
sheet that
QuarkXPress will

Note
To successfully convert Arabic text to curves, you should have Adobe Type
Manager  and Type 1 Arabic fonts installed on your system. True Type fonts,
rather than Type 1 fonts, will cause Arabic text to disconnect when converting to
curves.

Creating an Arabic List
QuarkXPress allows you to create a list depending on the style sheets of text in
your document. This list can be used later to automatically generate the text
associated with each specified style sheet, and can be updated as your text
changes.

A good example of the use of lists is the ability to automatically create a table of
contents. You can create Arabic lists the same way you would create Latin lists
with QuarkXPress.

Example:  Automatically Generating A Table of Contents
Inside your document, create a paragraph style sheet that will be used for all
chapter titles, and another style sheet for all paragraph headings:
[ 1 ]  Go to the Edit menu, and select Style Sheets .
[ 2 ]  Click the New  button to create a new style sheet and name it Chapter 

Title .
[ 3 ]  Click on the Character Attributes Edit  button to define the Font, Size,

Color, Shade, Scale, and Type Style you want to use for your chapter titles.
[ 4 ]  Click the New  button again to create a new stylesheet and name it

subhead .
[ 5 ]  Apply these style sheets to all your chapter headings and paragraph

headings throughout your publication.
[ 6 ]  Go to the Edit menu and select Lists . The following dialog box will be 

displayed:

Working with Arabic Text
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Creating an Arabic Index
QuarkXPress allows you to add words to an index list, then automatically
generates the index with the number of occurrences and the page number of
each word in the document.
[ 1 ] Select Show Index

from the View menu.
[ 2 ]  Go through your

document and add
Arabic words to your
index by highlighting the
word and clicking the
Add  button from the

Index palette.
[ 3 ]  The Arabic words will be

added, along with the
page numbers and the 
number of occurrences
of these words.

At this stage, QuarkXPress
adds the word in the wrong
sorting order. You fix the
order later when you generate the index.

Generating the Index
[ 1 ]  Make sure you have an Automatic Text Box  in one of the Master Pages. 

Refer to the QuarkXPress User s Guide for more information.
[ 2 ]  Select Build  Index from the Utilities menu.

Format
Select an Arabic style in Add Letter Headings.

Level Styles
Select the style sheets you wish to use for every index level. Make sure the style
sheets contain Arabic fonts.

use to format the automatically generated TOC.
[ 13 ]  Click the OK  button to save the list
[ 14 ] In your document, create a box that will hold the list.
[ 15 ] Go to the Arabic menu and choose Tag Box To Arabic  (Ctrl+A for Mac).
[ 16 ] Select Show Lists  from the View menu. The following floating palette will

be displayed.

[ 17 ]  Click the Build  button to build the list.
[ 18 ]  A list of all paragraphs tagged to the style sheets in the list will be listed in 
the Arabic box.

Note
¥  Before building an Arabic list, make sure you Tag Box to Arabic .
¥   The Arabic list will not display correctly in the Lists floating palette, but the 

text will be generated correctly when you click the Build  button.

Working with Arabic Text
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Saving Arabic Documents
If you create and save a document that contains Arabic text boxes, it is tagged as
an Arabic document. You will not be able to open this document again if you do
not have ArabicXT installed on your system. The following alert message will
appear:

Opening Latin Documents
ArabicXT allows you to open Latin documents created with any version of
QuarkXPress and keep the document unchanged. When you open the document,
ArabicXT automatically tags all text boxes to Latin, and the default language tag
will be set to Latin. 

Fixing Corrupted Documents 
ArabicXT allows you to open and fix corrupted documents. While you are opening
a corrupted document, hold down the control key. ArabicXT performs a
consistency check on the document. If any corruption or damages are found, it
tries to fix it and displays a report of the problem.

If this procedure does not work, please contact Layout Ltd. technical support desk
for help.

Changing the Latin Mixing Method
If you open an ArabicXT document with Standard Mixing, and you wish to create
complex Arabic/Latin mixing in the same box, you can convert text boxes from
Standard Mixing to Enhanced Mixing:

¥  Ctrl+Opt+Shift+S
This shortcut key converts the selected text box from Enhanced Mixing to
Standard Mixing. If no text box is selected, this shortcut key converts the
whole document from Enhanced to Standard Mixing.

Working with Arabic Documents| 4342 | ArabicXT User’s Manual 
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Click the OK button and QuarkXPress automatically builds the index
by adding new pages to your document.

Sorting the Index
At this stage, the index is not sorted correctly, and the letter headings
are not correct.
[ 1 ]  Select the text that was generated.
[ 2 ]  Go to Layout Utilities  in the Arabic menu, and choose Sort

Arabic Text
This re-sorts the index and fixes all letter headings.
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QuarkXPress numbers pages in the Document Layout palette from left to 
right. If you follow the steps above to insert automatic page numbers in the 
document, the page numbers will be correctly numbered from right to left.

Note
If the Automatic Page Number box is a Latin text box, the document is 
considered a Latin document, and page numbering appears from left 
to right.

If the Automatic Page Number box is an Arabic text box, the document is 
considered an Arabic document, and page numbering appears from right to left.

¥  Ctrl+Opt+Shift+E
This shortcut key converts the selected text box from Standard Mixing to
Enhanced Mixing. If no text box is selected, this shortcut key converts the
whole document from Standard to Enhanced Mixing.

Creating Facing Pages Documents
[ 1 ]  Choose New Document  from the File menu.
[ 2 ]  Select the Facing Pages box.
[ 3 ]  De-select the Automatic Text Box.
[ 4 ]  Click the OK button, and page 1 is created.

If you open the Document Layout palette, you will notice that page 1 is on the
right spread. In an Arabic document, page 1 is on the left spread. Inserting an
empty page before the first page will fix this problem.

Note
If you select the Automatic Text Box option, QuarkXPress creates automatic
pages as your text flows from the left page to the right page.

Using Automatic Page Numbering
Single Pages Documents

Automatic page numbering in Arabic works exactly the same way it works 
in Latin documents:
[ 1 ]  In the master page, create a text box to hold the page number.
[ 2 ]  Go to the Arabic menu and choose Tag Box to Arabic  (Ctrl+A for

Mac).
[ 3 ]  Press ( + 3) for Mac to insert the Auto Page Number command.
[ 4 ]  Automatic page numbers will be added to all document pages using

this master page.

In Facing Pages Documents
Facing Pages in Arabic documents must be numbered from right to left. 
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ArabicXT MAC Font Mapping

ArabicXT  Macintosh Font Layout

Notes: 

1) Character ˘ at position F9 is a Kashida with width equal to 1/3 character 

at position 60.
2) Character at position CA is a Fixed Space. 
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The following pages contain all ArabicXT alert messages, their possible causes,
and how to work around them.

When importing Arabic text using the XPress Tags filter, formatted Arabic text that
uses Arabic System fonts must be remapped to ArabicXT fonts.

[ 1 ]  Click the List Fonts  button to list all used fonts in the imported text.
[ 2 ]  Re-map every missing font into an equivalent ArabicXT font.
[ 3 ]  Click the OK  button to apply the new fonts to the imported text.
[ 4 ]  Click the Continue  button to ignore the message.

Note
If you click the Continue button, ArabicXT will replace all missing fonts with the
default Arabic font specified in the Arabic Style Sheet.

When opening ArabicXT documents, some preferences saved with the document
may differ from the ones set as defaults in the current ArabicXT Preferences.

[ 1 ]  Click the Keep Document s Arabic Preferences  button, to use the settings 

ArabicXT Alert Messages
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saved with the document. This will leave the document unchanged and will
not cause any reflows.

[ 2 ]  Click the Use Current ArabicXT Preferences  button to ignore preferences 
saved with the document and to use the preferences currently set in the 
ArabicXT Preferences dialog box. This might cause text to reflow.

Preferences that may cause text to reflow are:
¥  Mixing settings
¥  Ligature Selection settings

Preferences that may cause output to differ, but will not cause text 
reflow are:

¥  Vowel Levelling settings
¥  Kashida Control settings

Note
When opening client files, service bureaus and reproduction houses  have to click
the Keep Document s Arabic Preferences button so that documents do not
reflow.

This version of ArabicXT will not run with the current version of
QuarkXPress. For more information, please contact Layout Ltd. technical
support at support@layoutltd.com
This message is displayed if you try to run ArabicXT with a non-international or
older version of QuarkXPress. You should contact Layout Ltd. technical support
desk for help.

Invalid Security Device.
Could not load ArabicXT. Please make sure security device is attached to a valid
ADB or USB port.
This message is displayed when the Security device (dongle) of ArabicXT is not
attached to the ADB or USB port while starting ArabicXT. To install the dongle,
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ArabicXT Alert Messages

Layout Ltd. for an update of ArabicXT!
This message is displayed when you try to open a ArabicXT document created in
a newer version of ArabicXT than the version you are currently using. Close the
document without saving, and contact Layout Ltd. for an update of ArabicXT.

You should not continue working with the document, because it may get damaged
and you may lose information.

The ArabicXT preferences file was created with a more recent version of
ArabicXT. Unpredictable results might occur. Quit application and remove
the ArabicXT preference file. Then restart QuarkXPress. Contact Layout Ltd.
for an update of ArabicXT!
This message is displayed when you try to install an ArabicXT preferences file
that was created with a newer version of ArabicXT, which may cause some
problems. Immediately quit QuarkXPress and remove the ArabicXT preferences
file.

Text too long to edit!
This message is displayed when you attempt to edit more than 256 characters of
Latin text mixed in an Arabic box using the Latin text editing window 
(Ctrl+Opt + ->).

This option will result in non-Standard Mixed bilingual documents:
¥  Auto Kerning will be turned Off.
¥  Mixed Latin cannot have multiple text attributes.

This message is displayed when you attempt to convert a document that uses
Standard Mixing into Enhanced Mixing. If you continue, Auto Kerning will be
turned Off, which will cause text to reflow. See Mixing Latin with English section in
the Working with Arabic Text chapter of this manual.

please refer to the Installation section of this manual.

Not enough memory to complete operation. Please quit QuarkXPress and
allocate more memory for it.
This message is displayed when ArabicXT runs out of memory while trying to
perform an operation. You should immediately quit QuarkXPress and allocate
more RAM for it

The font in the Arabic Style is not an Arabic font.
Please choose a font that starts with ’AXt’ in the Arabic Style and restart
QuarkXPress.
The Arabic font used in the Arabic Style Sheet must be an ArabicXT font.
ArabicXT fonts all start with AXt . This message is also displayed when the
Arabic font chosen in the Arabic Style Sheet is not installed in the System.

ArabicXT could not be loaded because the global ArabicXT font ’AXtGihaneLight’
could not be found. Please install this font in the system and run again.
This message is displayed the first time you attempt to run QuarkXPress with
ArabicXT and you have not yet installed the default ArabicXT font called
AXtGihaneLight . Install this font before you attempt to re-launch QuarkXPress.

Please refer to the Installation section of this manual.

This document was created with an earlier version of ArabicXT. It might
reflow!
If you open a document created with an earlier version of ArabicXT, it will open. 
Some text might reflow, so check your document before you output.

This document was created with a more recent version of ArabicXT.
Unpredictable results might occur. Please close this document and contact


